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INFRINGEMENT OF THIRD PARTY TECHNOLOGY AND ARE MADE IN RELATION 
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TIME WITHOUT PRIOR NOTICE. 
 

ADAPX CONTACT INFORMATION 
Adapx Inc. 
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WELCOME TO CAPTURX FOR ARCGIS DESKTOP  
Thank you for your purchase. Now you can put the power of digital pen technology to work. Capturx for 
ArcGIS Desktop is a powerful, easy-to-use, digital data collection solution that enables you to keep using 
paper maps. Our extension is the ideal way to create, import, edit, share, and act on paper-based data in 
and between geographic information systems (GIS).  
 
 
CAPTURX FOR ARCGIS DESKTOP USER GUIDE 
This document describes how to use Capturx for ArcGIS Desktop to add features to your map and how to 
review the features you have added. To make it easier for you to find the information you need, this guide 
is divided into the following sections: 
 

• Intended Audience and Conventions: This section describes the intended audience and 
conventions used in this document. 

• System Requirements: This section provides a detailed list of the system requirements you will 
need to use Capturx for ArcGIS. 

• Digital Pen and Paper Overview: This section gives you an overview of the digital pen, docking 
station, and the digital paper used with your map and describes how they work. 

• Getting Started with ArcGIS Desktop: This section describes the contents of the package and 
takes you through the steps for installing the software.  

• Overview of the Process: This section provides an overview of the process used to add and 
review features to your map. 

• Using Capturx for ArcGIS Desktop: This section provides step-by-step instructions for using 
the software and digital map to add and review features to your map. 

• Appendix A: Penx Control Panel: This section describes the Penx Control Panel used with the 
pen to specify download options, to use a password with the pen, and to view information about 
the status of the pen. 

• Appendix B: Supported Renderers: This section lists the renderers supported by Capturx for 
ArcGIS. 

• Troubleshooting and Maintenance: This section provides a list of common errors and solutions, 
instructions for changing the ink cartridge, and FAQ.   

• Product and Contact Information: This section provides a list of product specifications for the 
pen, contact and reorder information, care and maintenance information, and a section on how to 
record your pen identification number. 
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INTENDED AUDIENCE AND CONVENTIONS 
This user guide is intended for a general audience familiar with operating a PC and with Microsoft 
Windows® operating system. No previous experience with digital pens or digital media is required. This 
document does presuppose that you are familiar with the ArcMap application and its features. If you have 
not already used ArcMap, we recommend that you take some time to become familiar with their features 
and capabilities.  
 
This document focuses on ArcMap on how it is used with the Capturx for ArcGIS extension. If you 
would like more information about ArcGIS Desktop applications, the following link takes you to the 
ArcGIS Desktop help: 
 
 
ArcGIS Desktop Help: 
http://webhelp.esri.com/arcgisdesktop/9.2/index.cfm?TopicName=What_is_ArcGIS_9.2 
 

Conventions Used in This Document 
This guide uses the following conventions for required actions: 

• Menu items and mouse operations are shown in bold fonts, with the steps separated by ">", for 
example:  

o Click Tools>Extensions 
 
 

SYSTEM REQUIREMENTS 
In order to successfully install and run your Capturx for ArcGIS extension, you must make sure your 
computer and printer meets these requirements: 
     
Basic Same qualifications required for prerequisite ArcGIS Desktop 9.2 application 

http://www.esri.com/software/arcgis/arcinfo/about/systemrequirements.html  
Computer and 
processor  

1 to 1.6 gigahertz (GHz) or higher processor, depending on ArcGIS version used. 

USB USB 1.0 or greater for docking up to 6 Penx simultaneously and any number of 
Penx sequentially; Penx must be docked at the workstation where the map was 
printed 

Memory 512 megabytes (MB) or higher 
Hard disk 12 MB  
Drive CD-ROM or DVD drive for installation  
Display Monitor with 1024x768 or higher resolution; Color depth greater than 256. 
Operating system Microsoft Windows XP with Service Pack 2 (SP2), .NET 2.0 or greater 
Printing  Adapx recommends the following configurations when printing with Capturx. 

Printers: 
Qualified color printers (guaranteed performance for the life of the printer):  
Oki C5400, C6100, C5900,  C6100, C96001 
An assortment of tested color laser printers and plotters can be found at: 

                                                      
1 Other model numbers used outside the United States. 

http://webhelp.esri.com/arcgisdesktop/9.2/index.cfm?TopicName=What_is_ArcGIS_9.2
http://www.esri.com/software/arcgis/arcinfo/about/systemrequirements.html
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www.adapx.com/support/ 
Essential requirements for printers: CMYK color, Postscript Level 2 support, true 
600 dpi for laser or true 1200 dpi for ink jet,  

Ink Laser toner or inkjet pigment ink for black (K),2 traditional dye (CMY) color 
inks.3

 

Paper White paper, the brighter the better, medium bond.4

Additional Actual requirements and product functionality may vary based on your system 
configuration and operating system. 

Network Internet access required during product registration, initial Penx connection and 
while restocking pattern. 

 

                                                      
2 High absorption in the wavelengths 800-950. 
3 Minimal absorption in the wavelengths 800-950. 
4 Uncoated with weights > 60 g/m, opacity > 88%, surface roughness, Bendsen (ml/min) between 100-400. 
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PEN, DOCKING STATION AND DIGITAL PAPER OVERVIEW 
The following section provides an overview of the digital pen (Penx™) and the docking station you 
received in your Capturx for ArcGIS package. This includes a description of the digital paper you will use 
to print your maps. 
 
The pen looks and feels just like an ordinary ballpoint pen and you use it in the same way (see Figure 1).  
There are no keys to press. You activate the pen simply by removing the cap and deactivate it by 
replacing the cap. The docking station is used to dock your pen and to connect your pen to a PC or laptop 
via the USB port. The docking station consists of the base, insert, and the USB slave port you use to 
connect the docking station to your computer (see Figure 1).  
 
 
 

 

 

 

 
 
 
 
 
 

 

 Figure 1 Adapx Pen and Docking Station 
 

 

The Digital Paper Used with Your Map 
You write on the digital map the same way you write on regular paper. Digital map paper is regular paper, 
but it is printed with specially arranged dots known as Anoto® pattern when you print your map. The 

Docking 
Station Base 

Docking Station Insert 

USB Cable 
Connected to Insert 

Insert Placed 
in the Base 

Pen Inserted 
into Docking 
Station 

Non-Slip Textured Coating 
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built-in camera captures the location it traverses on the page by seeing the dot patterns based on your 
handwritten notes, and the captured information is processed into digital signals by the pen’s CPU. To 
capture your ink strokes and annotations, you need to hold the pen facing up, away from the map so that 
the beveled edge of the pen tip is facing the paper. 
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GETTING STARTED  
This section provides a list so you can verify the contents of the package and describes how to install the 
Capturx for ArcGIS software. This includes 
 

• Verifying the package contents 
• Installing the required software  
• Charging your pen  

 
Open the email you received from Adapx with the product keys you received when you purchased this 
product. You will need them during the installation and first use of the product. 
 

Verifying the Package Contents  
The Capturx for ArcGIS Desktop package is shipped with the following items: 
  

• Your ArcGIS Extension CD 
• Capturx for OneNote kit with each seat license 

 
Your kit contains the following 
• Capturx software bridge to Microsoft Office OneNote 2007 
• Installation CD with owner’s manual,  
• Quick Start Guide 
• Penx digital pen 
• Fisher Penx replacement ink cartridges 
• Adapx/Rite in the Rain digital field notebook 
• USB dock 
• USB cable 

 
USING CAPTURX FOR ARCGIS IN EVALUATION MODE 
30-day trial begins with activation, which the customer can start at any time. Ends on 30th day or when 
pattern is depleted for the evaluation product. Evaluation products have access to 256 pages of A4 and 32 
pages of A2 and A0 pattern. During evaluation, the product can be activated at any time by running the 
License Manager. 
 

LICENSE REQUIREMENTS OVERVIEW  
The product requires activation of your pen and a license for the Capturx for ArcGIS Desktop Extension. 
The topics below describe the registration process. This process includes validating the license for your 
extension and for ensuring that the pen you are using has been enabled for use with that product. The 
topics below describe what you need to do to register your extension and your pen.  
 

PRODUCT REGISTRATION  

Capturx for ArcGIS Desktop requires a license and your pen must be activated. The registration 
process involves the following steps: 
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• After installation of the Capturx for ArcGIS Desktop Extension, you will be prompted to 
enter a product key for your plug-in. If you do not, you will enter into a 30-day trial 
period for the product. 

  
• After printing a file using the Capturx for ArcGIS Desktop Extension, when you dock 

your pen for the first time (and it has data for in the extension to process), you will be 
prompted to use a pen license. 

 

LICENSE REQUIREMENTS FOR PEN AND PLUG-IN  
The following section outlines the process used to validate the licenses required for Capturx for 
ArcGIS Desktop Extension and for your pens. 

Note: You need to be connected to the internet whenever you wish to activate a pen for use with 
Capturx for ArcGIS. 

Extension License 

A license is activated either during installation or by running the License Manager tool, which 
can be found in Start\Program Files\Adapx\Capturx for ArcGIS\: 

 License Activation/De-activation 

  
  Figure 2 License Activation/Deactivation  
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Figure 3 De-Activate Selection 

To activate, follow the same steps, but instead of being prompted to de-activate, you will need to 
enter the License Number you received with your product in the screen shown above. The 
extension will then be registered to your machine.   

  
Plug-in Connection for the Pen 

When you dock a pen, the system will check to see if the pen has been enabled for use with the 
Capturx product that printed the document. If the pen has been activated, the data will download. 
If it has not been enabled for that product, a dialog will prompt you whether you would like to 
activate your pen. However, unlike the extension license itself, the extension connection license 
is not restricted to a single machine (the pen can be used on any Capturx workstation where the 
same product is installed). 
 

Charging Your Pen 
The pen contained in the package needs to be charged before you can use it to capture data with your 
map.  
 
To charge the pen: 
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1. Take one of the ink cartridges and gently slide it into the hole at the tip until it is completely 
seated and doesn’t fall out.  It’s normal for the cartridge to feel slightly loose. 

2. Attach the docking station to a PC or laptop via the USB port. 
3. Fully insert the pen in the docking station.  
4. The gold connection points on the pen and docking station need to be aligned and the pen needs 

to be firmly placed in the docking station. 
5. After you connect the USB port to your computer and dock your pen, you will initially need to 

keep the pen in the docking station for four hours for it to fully charge.  

Note: To prevent your battery from running low, do not leave the cap off the pen for extended periods of 
time. You will need your pen cap so keep it safe. 

 
Note: For information on using the password feature, see Appendix A Penx Control Panel. 
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Installing the Software  
The installation contains the Capturx for ArcGIS Desktop extension and the Penx Control Panel used to 
access and manage your ink and digital pen. 
 
To install Capturx for ArcGIS Desktop: 
 

1. Insert the Capturx for ArcGIS Desktop CD-ROM into the CD-ROM Drive. If the installation 
window does not appear, run the setup or setup.exe by selecting Start>Run and selecting your 
CD-ROM drive. 

2. Follow the setup instruction on your screen. 
 
 
After you have installed the software and restarted your computer, the Penx Control appears among the 
system tray icons. See Appendix A Penx Control Panel for more information on the Panel and how it is 
used. 
 
 

  
Figure 4 Penx Control Panel Tray Icon 

 

Penx Control 
Panel Tray 
Icon 
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CAPTURX FOR ARCGIS DESKTOP OVERVIEW 
This section provides an overview of ArcGIS desktop and how it is used. This includes: 
 

• A flow diagram showing the process involved in using Capturx for ArcGIS Desktop 
• An overview of layers and legends and how Capturx for ArcGIS Desktop is used to update layers 

with new information 
• A description of the Capturx for ArcGIS Desktop extension toolbar. This includes a description 

of each of the buttons on the toolbar and its purpose 
 
Note: ArcView, ArcEditor, and ArcInfo are three versions of ArcGIS Desktop, and each of these includes 
ArcMap.  All of these versions are supported. 
  

Overview of the Capturx for ArcGIS Desktop Process  
The following process flow shows you the overall process used to capture, review, and edit your features 
and annotations. This includes the steps involved in: 
 

• Preparing and printing your map and legend 
• Using the pen to create ink strokes on the map 
• Docking the pen and transmitting the features you have created  
• Reviewing and editing your changes using the Capturx ArcGIS Desktop extension 
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Maps and Legends Overview 
The following overview provides a brief description of layers and legends, how they are related, and the 
role the legend and map play in using Capturx for ArcGIS Desktop.  
  
A layer is a visual representation of a geographic dataset in any digital map environment. When you add a 
dataset to ArcMap, a layer is created, and each map layer is used to display and work with a specific GIS 
dataset. Thus, a layer always reflects the most up-to-date information in your database. A layer won't 
show on your map unless you also have access to the data source on which the layer is based. You can 
think of a layer as a slice of the geographic reality in a particular area. On a county map, for example, 
roads, parks, fire stations, and city boundaries might be considered different layers. 
 
A legend item on the map portrays a feature or class of features (depending on the renderer) that belongs 
to the layer, and the legend shows you the different layers available on your map and in your database. A 
legend, therefore, depicts the types of features (layers) displayed in the map layout.  
 
The Capturx for ArcGIS extension enables you to update the layers in the database by using the legend 
and map to add features on your map. For example, a field worker might want to update the number of 
roads and parks on the current county map. Using the legend, printed map and digital pen, the field 
worker can mark the location of a new county road and park on the map and update the parks and county 
road layers with this new information. 
 
The ArcMap Legend Wizard described later in this guide allows you to select the layers you want to place 
in the legend so you can work with them using the Capturx for ArcGIS extension. The Legend Wizard 
also allows you to choose the appearance of the legend title and legend frame.  
 
See the ArcGIS Desktop Help for a more detailed discussion of map layers and how they are used:   
http://webhelp.esri.com/arcgisdesktop/9.2/index.cfm?id=177&pid=174&topicname=Map_layers 
 
 

Capturx for ArcGIS Desktop Toolbar Overview 
At the most general level, the Capturx for ArcGIS extension toolbar is used to: 
 

• Add one or more annotation layers to your map 
• Print the page layout containing the map and legend you have selected 
• Use the import options import the ink strokes you have made on your map so they can be 

reviewed and accepted or rejected 
• Use the review options for selecting the ink strokes you have made and accepting or rejecting 

these changes  
 
The following overview provides a description of the toolbar and how each of the buttons is used to 
perform these general tasks.  
 

The States of the Toolbar and Buttons 
The toolbar consists of 12 buttons and some of these buttons will be disabled (grayed out) depending on 
where you are in the process of capturing and reviewing your field data and whether you are in layout or 
data view. As shown below, the toolbar can be in different general states with different options disabled: 
 

http://webhelp.esri.com/arcgisdesktop/9.2/index.cfm?id=177&pid=174&topicname=Map_layers
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Printing Your Map and Importing a Session 
The buttons highlighted below are used to add an annotation layer to your legend, to print the map and 
legend you have selected, and to import your session(s) into ArcGIS so they can be reviewed. 
 

 
 

 
Figure 5 Printing and Importing 

 

Toolbars Available in the Review Mode 
After you have docked your pen and imported your sessions, you can use the buttons highlighted below to 
select features, accept or reject all the changes you have made to your map The first toolbar shows you 
the options available in the layout view and the second shows you the options available in the data view. 
 

 
 

 
Figure 6 Reviewing Sessions 

 
 

 

Add Annotation Layer: This button is used to add an annotation layer that 
you can use to write annotations on your map.   This takes you to a dialog box 
that enables you to: 

• Select the data frame you want to apply the layer to 
• Provide a name for the annotation layer 
• Select the path to the location where you want to store the files. 

 

Print Page Layout: This button is used to print the page layout.   This takes 
you to the print dialog.  

 

Import Next Session for Current Map: This button is used download the 
current session for the map you are working on so that your changes will 
appear on the map.  This button is only active if there are sessions waiting for 
the currently loaded map. 

 

Open the Session Dialog Box: This button will show you a current list of 
sessions you have uploaded using your pen so you can choose a session from 
the list. This dialog includes the  

• Name of the map 
• User name associated with the pen 
• The time and date the upload was received 

You can also use this dialog box to delete a session. Sessions that correspond 

Layout View 

Data View 

Initial State 

Ink Ready for 
Docking 
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with other maps will be inactive. 

 

Select All Capturx Features: This button is used to select all of the features 
(including user features and annotation strokes) you have made on your map.  

 

Clear All Selected Features: This button is used to unselect any of the 
features you have made on your map  

 

Select the First Change: This button is used to select the first feature you 
have made on your map  

 

Select the Previous Change: This button is used to select the previous 
feature you have made on your map  

 

Select the Next Change: As you move through the changes you have made, 
this button is used to select the next feature you have made on your map.  

 

Select the Last Change: This button is used to select the last feature you 
have made on your map. 

 

Reject All Changes: This button is used to reject all of the feature you have 
made on your map  

 

Accept All Changes: This button is used to accept all of the features you 
have made on your map. 

 

Deleting and Modifying Features during the Review Session 
When it comes it making changes to your geo-database, ArcGIS Desktop only “knows about” one data-
source at a time. For this reason, the data-source must be chosen before any editing in the tool can take 
place, although the data-source may be referenced by multiple layers in your map. This is true even 
though Capturx for ArcGIS Desktop opens edit-sessions for other data-sources that you may have inserted 
via electronic ink.  
 
For this reason, Capturx must decide which data-source to open in the editor and which to open in the 
background. Capturx prefers your user-datasources to its own (such as the markup layer), and the first 
user-datasource encountered wins over any subsequent ones. You will be able to use the ESRI-provided 
delete function (via the Delete toolbar command, or Edit->Delete) to delete the selected feature when it is 
enabled. This will happen when the selected feature belongs to the data-source shown in the editor 
toolbar.  
 
During the review session you will not be able to delete features belonging other datasources – to do so, 
you must accept all changes and start a new edit-session for each data-source you wish to target, and 
delete these features outside of the Capturx review session.  
 
Note: The next version of Capturx for ArcGIS Desktop will contain more advanced and flexible review 
and correction facilities to make this process easier. 
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OPENING A MAP AND CREATING A LEGEND 
As described in the previous section, a legend item on the map is equivalent to a layer, and the legend 
shows you the different layers available on your map and in your database. A legend, therefore, depicts 
the types of features (layers) displayed in the map layout.  This section describes the process for opening 
a map and creating and placing the legend you will use to add features to your map. This includes: 
 

• How to open the map you want to use with Capturx for ArcGIS Desktop 
• How to use the ArcMap Legend Wizard to select the layers you want to include in your legend. 

 
To create a map and legend: 
 

1. Open ArcMap.  
2. Select the map you want to use (see Figure 7).  

 

 
Figure 7 Selecting a Map 
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3. From the View Menu, select Layout View.  

 

 
Figure 8 Selecting Layout View 

 
4. From the Insert Menu, select Legend. 
5. Use the Legend Wizard to select the layers you want to include in your Legend (see Figure 9). 

 

 
Figure 9 Selecting Legend Items 

 
6. Select Next. 
7. The items you have selected will appear in the legend. You can also right-click on the legend and 

choose Properties to modify it later. 
8. Use your mouse to drag it to the desired location on the map and to resize it. You can save the 

map or print it. See the next section for instructions on printing the page layout and legend. 
 
Note: See Appendix B for a list of the renderers that are supported with the Capturx for ArcGIS 
extension.  

 
Select 
Layout 
View 
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PRINTING YOUR MAP AND LEGEND 
This section describes the process for printing your map and legend with digital pattern. This includes: 
 

• The license requirements for your pen and for Capturx for ArcGIS desktop, including the process 
used to validate both of these licenses 

• How you select an appropriate printer to print the map and legend, including a description of the 
printer requirements for using Capturx for ArcGIS Desktop 

• After you have selected the appropriate printer, a description of the process for printing the map 
and legend, including a description of how to use the Capturx Pattern Refill dialog box to get the 
pattern you need to print your digital map 

 

Printing the Page Layout and Legend 
As noted in the section under License Requirements, you use pattern to print your digital map. Before you 
print, you need to know how the pattern is used when you print your map and how to select the pattern 
size that best meets your needs. This section describes: 
 

• How the pattern is used to print your digital map 
• The process used to print the pattern 
• How to use the options on the Pattern Refill dialog box to obtain the pattern you need 
• How to use the Printing dialog box to learn how much pattern you have available and how to get 

more pattern when you are running low 
 

How the Pattern is Used to Print Your Digital Map 
A certain amount of pattern is required to print the digital map you will use, and these different size 
patterns are used to print different size pages:  
 

• A4 pattern can print up to 14” x 14” (You can print A4, letter or legal, in any orientation) 
• A2 pattern can print up to 23.4” x 23.4” 
• A0 pattern can print up to 46.8” x 46.8” 

 
A larger size pattern can be used to print a smaller size page layout. For example, one-square-yard “A0” 
can be used to print a letter-size 8.5” x 11” page layout. However, there are fewer pages in a refill of a 
larger size pattern, so it is more cost efficient to use the smallest size pattern you can. 
 
If you have downloaded pattern that is too large for the size you would like to print (“A0” being used to 
print a letter-size 8.5” x 11” page layout) you can still print, but you will see a warning notice in red text 
at the lower left of the print dialog noting that you could use smaller pattern. 
 

Monitoring and Using Pattern in ArcGIS Desktop 
Capturx for ArcGIS provides you with a Pattern Refill dialog box and a Desktop printing dialog that you 
use to download pattern and to monitor that amount of pattern you have (see Figure 10). 
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Figure 10 Pattern Refill and Printing Dialog Boxes 

 
When you’re in the Pattern Refill dialog, you have the option to download any size pattern that you don’t 
already have more than 1000 pages of.  If you already have more than 1000 pattern pages, the checkbox 
for that size will be grayed out. 
 
The bars on the pattern control are full/green at 1000 pattern pages or more If there is less than 800 pages 
left you can find out exactly how many pages you have by hovering on that bar, otherwise the hover text 
just reads ‘full’ (see Figure 11).   
 
 

Figure 11 Hovering Over Pattern Bars 
 
You may need to buy some more pattern refills at some point, although your initial purchase provides you 
access to 1 digital pattern shelf per pen Extension Connection license purchase (each shelf contains over 
6,100 sheets of A4 digital printing pattern).  A 5 digital pen package provides over 31,000 unique pattern 
pages for your Capturx for ArcGIS solution. You can purchase more from the Adapx store at: 
 

Pattern Refill 
Dialog Box 

Desktop 
Printing 
Dialog Box 
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 http://www.adapx.com/index.php?/How-to-Buy.html 
 
To print the page layout and legend 
 

1. Within ArcMap, select printer options by selecting File>Page and Print Setup. 
 

 
Figure 12 Selecting the Page and Print Setup Menu 

 
2. This will open the Page and Print Setup window (see Figure 13). When using this window: 

 
• Set your printer to use the size of paper desired as the “default tray”, since the “source” 

(paper tray) setting in this Page and Print Setup window is not currently supported 
• The “Show printer margins on layout” option is helpful to keep your page elements (map, 

legend) within the area of the page that will actually be printed. 
• Select the Use Printer Paper Settings radio button 

 
Note: The “Layout View” shows exactly what will be printed, including the orientation of the page. 
 

Select Page 
and Print 
Setup 

http://www.adapx.com/index.php?/How-to-Buy.html


Capturx for ArcGIS Desktop User Guide 24

 

Rev: A Last Modified on: 6/27/08 
  

 
Figure 13 Page and Print Setup Window 

 
 

3. You need to be in the Layout View to print your map. Select View>Layout View to print your 
map. 

 

 
Figure 14 Selecting Layout View 
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This will display the map in “Layout View” (see Figure 15). This view provides rulers and printer 
margins that will help you see the actual orientation of your page layout (portrait or landscape) and 
determine how the page is printed.  In other words, if it is 11” wide by 8.5” tall, it will be printed 
landscape style. 
 
By showing you the size of the page layout these rulers also show you what size paper you should be 
setting your printer to use (make sure that the printer’s “default tray” is using paper of that size.)  As 
noted above, you must set the default printer tray to the size you like before printing or loading the 
appropriate size paper you are using into the default tray.   
 
As noted below, in the Page Layout, you might want to keep anything you want to write on, such as a 
map frame or a legend icon, at least 7 mm away from the printer margins. 
 

 

 
Figure 15 Map in Layout View 

 
4. Select the print button on the Capturx toolbar to print current layout. 

 

 
Figure 16 Print Button 

Ruler 
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Note: If the legend has layers that represent types of database that we cannot modify, or that we are not 
able to use fully, a “Layer Support Information” form will pop up before printing. This form lists the 
unsupported layers and unsupported symbology.  

• Unsupported Layer means that legend icons representing features from that layer cannot be used 
to create features.  

• Unsupported Symbology means that legend icons representing features from that layer will 
always create the ‘default’ feature, whatever it would be for that database/table.  

If you see this form, you can cancel printing, or continue on to print.  
 
Using the Pattern Refill Options 
When you print for the first time, you need to download pattern in the desired size before you can print. 
You should choose pattern of the smallest size that will suit your needs. For example, if you are usually 
printing letter-size maps, choose “A4” pattern to download. At any time, if you don’t have any pages of 
the size needed to print your current page layout, you will get the pattern refill dialog before getting the 
printing dialog. 
 

5. Select one or more checkboxes for the pattern size you want and select the Refill button.  Your 
pattern will be refilled via a download from Adapx.   

 

 
Figure 17 Capturx Pattern Refill 

 
6. After you have downloaded the pattern you need, select the print button on the Capturx toolbar to 

print current layout. 
 
The Capturx for ArcGIS Printing dialog opens (see Figure 18). This dialog provides two ways to tell you 
the status of your pattern and to let you know when you are running low: 
 

• The status bar becomes shorter and changes in color as you use your pattern. The color changes 
from green to yellow to red as you use up the available pattern.  

 
• When you reach 100 pages, a message will appear at the bottom of the dialog 

 
When you’re in the print dialog, you always have the option to try to download another pattern refill, by 
pressing the “Get More Pattern” button.  Using this button is a good idea if you see the “Could use 
smaller pattern” warning, and you expect to be printing this size page fairly frequently. 
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When the color changes to red or the message appears, you need to select the Get More Pattern button. 
This will take you back to the Pattern Refill dialog (see Figure 18). 
 

  
Figure 18 Capturx for ArcGIS Printing dialog 

 
7. If printing large format maps, you may need to reduce the number of colors or the resolution 

(DPI) of the map images. To do this, use Capturx for ArcGIS’ Advanced Printing Options dialog. 

 
Figure 19 Advanced Printing Options dialog 

Status Bar 
Decreases 
and Changes 
Color 

Get More 
Pattern  
Selection 

Advanced 
printing 
options 
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8. Using the Capturx for ArcGIS Printing dialog, select the numbers copies and then select OK (see 

Figure 18). 
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How to Use Capturx for ArcGIS Desktop 
The following section describes the digital map and legend and how they are used to add features on your 
map so you can update the desired layer with new information.  
 

Tips for using the legend 
The legend contains icons for feature types. You select the feature types by checking the desired feature 
type with the digital pen. The “feature type” refers to the symbol used for representing the feature on the 
map. You can select the feature type by using a checkmark or by drawing a short line through the feature 
type. You draw a line through the color line to select the color for your annotations (see Figure 36).  
 
Note: To correctly capture your feature, you need to spatially limit the size of your mark you use to the 
desired feature. Imagine there is a border around the feature that limits the size of your mark. 
 
Warning: If you do not select an icon before writing, your ink may be lost or result in the creation of 
unintended feature types. If you attempt to write an annotation without selecting a legend item first, you 
will receive a warning that the imported session had no effect on any Geodatabases. You will be given the 
options to remove the session or to revert to the previous state. 
 
 

  
Figure 20 Legend with Feature Types  

 
 
How to Use the Map and Pen to Create Features 
You use the pen to select icons from the legend and then mark the desired location on the map to place 
these features.  
 

 
Selecting 
the Desired 
Feature Set 
with Your 
Pen  

 
You Draw a 
Line with Your 
Pen to Select 
the Desired 
Color for Your 
Annotation  
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To produce features on the map:  
 

1. First, check the icon on the legend for the feature you wish to produce.  
2. Then each stroke on the map page indicates where these features should be produced on the map.  
3. You may select a different feature type by checking the appropriate icon on the legend page at 

any time, after which each stroke will produce that kind of feature.  
4. You may select the feature types in the Adapx Ink Annotation group to produce written 

annotations on the map which will appear on the Ink Annotation layer. (Note: your legend may 
not be set to display the “Adapx Ink Annotation” group name.) 
 

For example, to add a fire station, check its icon in the legend and mark its location on the map with a 
single dot of the pen. Switch to an annotation feature, a red marker, by checking its icon in the legend, 
then write the acronym ‘FS’ next to the location of the fire station to remind you that it was added there.  
 

 

The Types of Features and How They are Used 
Capturx for ArcGIS can create features on the map with three kinds of geometries: 
 

• Point features are represented by icons on the map; their location is a single point 
• Line features are represented by a series of points; their location is a series of points 
• Area features are represented by a series of points that are defined as representing an “inside” and 

an “outside” 
 
Each of these features is created by first selecting an icon on the legend and then marking the desired 
location on the map.  All the strokes made on the map between selecting one feature icon on the legend 
and another icon creates multiple instances of each kind of feature from each stroke.   
 
You should use one of the annotation feature types to write notes or comments. If you select the Building 
(a point-type feature) and then write the word “building”, a building icon would appear every place the 
pen touched the map during the writing of “building”, so be sure and switch to the annotation feature to 
write any notes or comments. 
 
Note: The digital pen does not work well at the edges of the map. Allow a 7 mm margin to ensure that 
your ink strokes are captured correctly. 
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DOCKING THE PEN AND TRANSMITTING YOUR CHANGES 
This section describes how to dock the pen and upload your digital ink. The Penx Control Panel described 
in Appendix A is used to select the download option you want to use. 
 
To upload the digital ink using the pen  
 

1. Attach the docking station to a PC or laptop via the USB port. 
2. Fully insert the pen in the docking station. The gold connection points on the pen and docking 

station need to be aligned and the pen needs to be firmly placed in the docking station. 
3. After you connect the USB port to your computer and dock your pen, semi-transparent Status 

Window will also show you the progress of the download (see Figure 21).  
 

 
Figure 21 Penx Downloading  

 

PENX CONTROL PANEL OVERVIEW 
The pen and the downloaded ink are managed using the Penx Control Panel. This control panel enables 
you to specify download options, assign a password, and to obtain status information about the pen and 
the download. The Penx Control appears among the system tray icons in the lower right corner of the 
screen.  
 

  
Figure 22 Control Panel Tray Icon 

 
See Appendix A for a detailed discussion of the Penx Control Panel and instructions on how it is used.

Penx Control 
Panel Tray 
Icon 
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REVIEWING THE CHANGES YOU HAVE MADE 
After you have uploaded your changes, you can review them. The following section describes how you 
review the changes you have made to your map. This includes 
 

• Using the Session Selection window to choose the particular session you want to review 
• A description of the reviewing options available with the Capturx toolbar and the process for 

accepting or rejecting the features you have added. 
  
  
To Import Your Review Session 
After you have docked your pen and imported your sessions, you can use the buttons highlighted below to 
select, accept or reject the changes you have made to your map The first toolbar shows you the options 
available in the layout view and the second shows you the options available in the data view. 
 

 
 

 
Figure 23 Reviewing Sessions 

 
To review changes on the map:  

A. Select the Import Next session button  on the Capturx toolbar to download the next session 
available on the current map so that your changes will appear on the map.   

 
Or  

B. The Select Session Activate button  on the Capturx toolbar and it will show you a current list 
of sessions you have uploaded (see Figure 24). This includes the  

 
• Name of the map 
• User name associated with the pen 
• Time and date the upload was received 

 
1. Select the Import button to upload the desired session or double-click on the item. The Import 

button is only enabled for sessions associated with the current map – to load a session for another 
map, you must first load the desired map into ArcMap, then import the session. 

 
 

Layout View 

Data View 
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Figure 24 Session Selection Window 

 
2. The features you have made will be shown on the map (see Figure 25). 

 
 
To Review Your Changes 
The following section takes you through the process for reviewing the changes you have made. 
 
 

 

 

 

Figure 25 Selections Appear on the Map 
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3. Use the Capturx toolbar to select all pending changes or to step through your features one at a 
time. The feature you select will be highlighted on the map (see Figure 26). 

4. Use the Accept all button to accept all changes (reviewed or not) made to the geodatabase. Use 
the Reject all button to reject all changes (reviewed or not) made to the geodatabase (see Figure 
26). 

 

 
Figure 26 Capturx for ArcGIS Toolbar 

 
5. When you select the Reject All button the following window will appear asking you to cancel the 

rejection, remove the session you have just imported, or to revert the session so you can re-import 
it again at a later time.  

 
 

 
Figure 27 Review Options  

 
 
 

Note on editing sessions for advanced users 
Adapx Capturx for ArcGIS opens an edit session in the editor when you import ink into your database. 
 (You must close any existing edit-sessions before Capturx will allow you to import your digital ink.) 
ArcGIS Desktop is designed to only edit one datasource at a time, so to support automatic entry of all 
features you’ve added with your Penx, in addition to one edit session which is opened on your behalf in 
the editor, Capturx maintains parallel, synchronized edit sessions for your additional datasources, such as 
the Adapx Ink Annotation layer or other user-layers that reference additional geo-databases.  While the 
state of all edit sessions is unified, it is recommended you use the Capturx toolbar commands to Accept 
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and Reject your imported edit sessions, rather than using the ArcGIS editor’s Stop Editing command, 
since this will provide you with added benefits, such as the ability to revert your ink session if changes are 
rejected. 
 
Notes: 

- Capturx prefers user datasources to its own, so it will only open one of its own layers in the editor 
if there are no user-features to add, but only Capturx annotations. 

- Currently, the first user dataset that is inked has preference in the editor. 
- While the correction process is in progress, you may also manually edit any of the layers in the 

editors Target: list. 
To manually edit another datasource, you must accept or reject the Capturx changes first, then 
open a new edit session as you normally would.  

- In Capturx 1.0 you must accept or reject all imported changes at one time.  
Although you may accept all Capturx changes and restart an edit session manually at a later time 
to adjust previously imported features, there will no longer be a mechanism to distinguish 
previously imported features from other features that may exist in the geo-database. 
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PEN CONTROL PANEL 
 The Penx Control Panel enables you to specify download options, assign a password, and to obtain status 
information about the pen and the download. The Penx Control Panel options include: 
  

• Viewing the docked and/or unlocked status of the pen 
• Entering and saving personal details to the pen 
• Assigning a password with the pen 
• Viewing the remaining time left on the battery of the pen 
• Downloading and deleting the pages currently on the pen 
• Setting how you want the pages to download 
• Enabling or disabling the Bluetooth feature on the pen 

  
Four icons are used to show you status: 
  

• White Pen: No pens docked 
• Green Pen: One or more pens are docked 
• Green Blinking Pen: Docked data pending download 
• Green Spinning Pen: Currently downloading data for one or more pens 

  
Hovering over the system tray icon with your mouse pointer will provide you with the battery 
information, current number of pages on the pen, and memory status of the pen. When you are 
downloading, a semi-transparent Status Window will also show you the progress of the download. 
You can access the Penx Control Panel by double-clicking on the Penx Control Panel icon in your system  
Tray 

 . 
 
The Penx Control Panel is divided into tabs, a docking status indicator, and four main sections and 
options.  Each of these is identified by number and in the description below (See Figure 4): 
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Figure 28 Pen Manager 

 
Tabs Separating Each Pen (1) 
Tabs are used to separate the Penx Control Panel options for each individual pen. Selecting the tab will 
show you the Penx Control Panel options for the tab (pen) you have selected. 
  
Note: When multiple pens are used, docking a particular pen does not automatically switch the active tab 
to match that pen. You need to select the desired tab for the particular pen you want to view. 
  
Pen Docking Status (2) 
Pen status tells you if your pen is currently docked and unlocked (using the password). If the pen is 
undocked, the Penx Control Panel will show you the data from the last docking. Selecting the Unlock Pen 
button enables you to enter a password so you can unlock the pen. If you have separate pens using the Pen 
Manager, you can select the Forget Pen button when the pen is undocked to delete the cache information 
about the undocked pen selected using the tab. 
  
Personal Data Stored on the Pen (3) 
This section of the control panel is used to assign a password and to enter personal data to the pen. By 
assigning a password, you prevent someone else from downloading with the pen or viewing the personal 
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information you have entered. Once you assign a password, you will be asked to enter it before you can 
download data from the pen. The password options include: 
  

• Delete Button: Use this button to delete the password you have assigned 
• Change Button: Use this button to change the password you have previously assigned 
• Forget Button: Use this button to cancel the settings of any previously installed software that has 

been used with the pen. 
  
You can enter personal data by filling in the desired fields. 
  
Pen Status (4) 
This section allows you to view the following information: 
  

• Battery Status: Percent charged, writing time, and idle time left on the pen 
• Data on Pen: Percentage of free space left on the pen, pages remaining, and the number of current 

pages on the pen ready to download. You can also delete and download the current pages on the 
pen by selecting the desired button. 

• Based on average data per page, an estimate of how many pages you have left to use on the pen 
  
Pen Docking Status (5) 
This section allows you to select a download option. Note that the download options become less 
automated as you move down the following list. For example, if you select “Silent download” the data 
will be auto downloaded. The download options include: 
  

• Silent download –When you select this option, you will not see the dialog box showing the status 
of the download. 

• Automatically download – Data is auto downloaded as soon as the system detects a connected 
pen. You will see a dialog box showing the status of the download. 

• Prompt for download – When the system detects a connected pen, you are prompted for 
permission to download the data. 

• Manual Download – With the pen connected, the system will wait for you to initiate download 
using the Download button on the Pen Status section of the Pen Manager. 

  
Enable Bluetooth (6) 
This option allows you to use the check box to enable the Bluetooth feature on the pen. Selecting this 
option does not change or add any functions.   
  
Save to Pen (7) 
When you make a change on the Control Panel, the change will be shown in pink. Selecting the Save to 
Pen button will save the change you have made and the pink highlighting will disappear. 
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APPENDIX B SUPPORTED RENDERERS 
This appendix shows you the renderers supported by Capturx for ArcGIS desktop extension. The 
following five supported renderers are available from the Symbology tab under the Layer Properties 
dialog box. This tab shows the methods you can use to represent your data using the Capturx ArcGIS 
extension. 
 
Draw all features using a single symbol: 

 
 
Draw categories using unique values of one field: 

 
 
Draw categories using unique values combining up to 3 fields: 
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Draw quantities using color to show values: 

 
 
Draw quantities using symbol size to show relative values: 
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TROUBLESHOOTING AND MAINTENANCE 
This following section provides information on troubleshooting and maintenance. This includes: 
 

• Common errors and recommendations on how to resolve them 
• Changing the ink cartridge 
• Care and maintenance of the pen 
• Frequently asked questions about Capturx for ArcGIS Desktop, and the pen. 

 

Common errors and recommendations  
Below is a listing of common errors that can occur with the pen and recommendations on how to resolve 
each of the issues. 
 

Errors and recommendations for pen 
The pen does not turn on when I take off the cap. 
Make sure the pen is fully charged. Insert the pen into the USB cradle to recharge the battery.  
 
The pen does not charge when connected to the docking station. 
 

1. Make sure the computer is turned on. 
2. Make sure the docking station is connected to the computers USB port 
3. Make sure the pen is fully seated 
4. Try using another USB port on the computer.  

 
The pen does not download handwritten documents when inserted into the docking station. 
 

1. Make sure the computer is turned on. 
2. Make sure the Docking station is connected to the computers USB port 
3. Make sure you have installed the software you need to perform the download.  
4. Make sure you are writing on the required digital paper 
5. The pen will vibrate if you write outside the margins of the digital paper. When you are outside 

the margins, the vibration tells you the pen is no longer recording your text. 

Changing the Ink Cartridge 
You can change the ink cartridge by using the ink cartridge removal hole. This section takes you through 
the removal steps. The ink is under pressure, so be careful when changing the cartridge that you don’t 
break the tip. 
 
To change the ink cartridge: 
  

1. Remove the cap and place the ink cartridge in the hole provided on the shirt clip. 
2. Gently pull to extract the cartridge. 
3. Insert the new cartridge and press to fully seat.  
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Care and Maintenance of the Pen 
Your pen is a product of superior design and craftsmanship and should be treated with care. The 
suggestions below will help you protect your warranty coverage. 
 

1. Although the pen is designed to work on all-weather environments, try to keep the device dry. 
Precipitation, humidity, and all types of liquids or moisture can contain minerals that can corrode 
electronic circuits.  

2. Do not use or store the device in dusty, dirty areas. Its electronic components can be damaged. 
Always keep the cap on when you are not using the pen. 

3. If possible, try not to store the device in hot areas, as with any electronic components and 
equipment.  High temperatures can shorten the life of electronic devices, damage batteries, and 
warp or melt certain plastics.  

4. Do not store the device in freezing areas. When the device returns to its normal temperature, 
moisture can form inside the device and damage electronic circuit boards. 

5. Do not drop, knock, or shake the device. Rough handling can break internal circuit boards and 
fine mechanics. 

6. Do not use harsh chemicals, cleaning solvents, or strong detergents to clean the device. 
7. All of the above suggestions apply equally to your battery, charger, or any enhancement. If any 

device is not working properly, take it to the nearest authorized service facility for service. 
 

Frequently Asked Questions  
Below is a list of commonly asked questions about the pen and an answer to each of these questions. 
 

Q1. Is the pen waterproof?   
 
A1. No, the pen is not waterproof. Do not use the pen in locations subject to water or 

high humidity.  
 
Q2. How often should I recharge the battery? 
 
A2. Recharging the battery every 3 to 4 days is advisable if you use the pen for 1 to 2 

hours a day. It is a good custom to recharge the battery every day if you use the pen  
for 3 to 4 hours a day. 

 
Q3. How long does a fully-charged rechargeable battery operate? 
 
A3. Approximately two months after full charge. When the battery is left unused with the 

cap on for about two months, a “low battery warning LED” lights up. If the LED 
lights up, be sure to recharge the battery before using the pen. 

 
Q4. Can I replace the built-in battery myself? 
 
A4. No, you cannot replace the battery yourself. The warranty for the pen is void if you 

replace the battery yourself. Consult Adapx if battery replacement is required. 
 
Q5. Can I replace the ball-point pen myself? 
 
A5. Yes, the pen has a clip on the cap as a replacement adapter. Use the hole on the clip 
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to replace the ball-point pen with a new one.  
 
Q6. Can I use a spare general ball-point pen available at local retail shops? 
 
A6. The pen requires a triple action refill cartridge. We recommend that you obtain pen 

refills directly from Adapx, or from Rite in the Rain. The Adapx ink cartridge is 
pressured with a unique ink that is designed for note taking in extreme conditions. 

 
Q7. How long is the life span of a Pen? 
 
A7. The life span of a pen is about three years. This figure is calculated on the 

assumption that the pen is used for three hours a day. (This figure is just a guide and 
varies depending on conditions of use.) 

 
Q8. How much data can be stored in the pen’s built-in memory? 
 
A8.  The memory capacity of a pen is equivalent to approx. 40 pages in terms of 81/2 by 

11 paper depending on the density of the writing. We recommend that you transfer 
the data to your PC before the memory becomes full. 

 
Q9. Does a pen have a "memory full indicator"? 
 
A9. Yes, the vibrator in a pen oscillates to warn you when the memory is full. If the 

memory is full, it is no longer possible to save new data. 
 
Q10. Tell me about the accuracy or limit of resolution of the coordinates the pen can 
detect. 
 
A10. The maximum address error the pen can detect is 1.0mm, or the sum total of the 

following two conditions. 
1: Anoto pattern resolution: 0.3mm (dot pitch is 0.3mm) 
2: Address errors calculated by the locations of the pen and Anoto patterns vary 
depending on the angle of the pen against the paper. The maximum error is 0.7mm. 

 
PRODUCT AND CONTACT INFORMATION 
This following section provides information on:  
 

• Product specifications for the pen 
• Contact and reorder information 
• How to record your pen number 

 

Pen Specifications 
Model AMP-121 (Bluetooth® + USB model) 
Weight 30g 
Dimensions 153 x 19 x 17mm (without a cap) 

157 x 21 x 18mm (with a cap)  
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Data communication USB 1.1 standard (USB 2.0 standard can be used) 
Bluetooth 1.2 standard  

Operating temperature 0°C to 40°C (with no condensation) 

Built-in battery Lithium-ion rechargeable battery. Lasts up to 10 days 
between recharges 

Operation time 4 hours (120 minutes) or longer.  Memory stores up to 50 
pages between transfers 

Standby time 10 hours (min.) without a cap 
Charging time Approx. 2.5 hours 
Charging method Via cradle (AC adapter/USB) 

 

Contact and Reorder Information  
Use the email address, phone numbers, and URL below for technical support, sales, and to reorder parts.  
 
Troubleshooting and Technical Support  
Email: techsupport@adapx.com 
Phone: 866-208-9673 
 
Sales  
Email: sales@adapx.com 
Phone: 206-428-0800  
FAX: 206-428-0801 
 
Reorder Part numbers for Adapx Products 
The following part numbers can be used to order products 

• Penx – Model AMP-121 
• Dox-Penx waterproof transport case - Model AMD-110 
• Notebooks – 870FB 
• Ink refills – Available in packs of 5 and 10. FSPR-005 (5 pack) FSPR-010 (10 pack) 
• Capturx is built for Microsoft OneNote 2007 – ASMO4211 

 
You can reorder these products from Adapx at   
 
http://www.adapx.com 
  

Recording your pen serial numbers  
Each pen has a unique four-digit identification number used to deactivate the pen or to disable Bluetooth. 
For future reference, you can use the box below to enter pen information or to place your identification 
number and keep it in a safe place:  
 
 
 
 
 
 

Pen Model: ___________________________ 
Pen Serial No: ________________________ 
Bluetooth Addr: _______________________ 
PIN Code: ___________________________ 

mailto:techsupport@adapx.com
http://www.adapx.com/
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